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Working with Files and Folders 
 
Use the Windows Explorer (not to be confused with the Internet Explorer), Understand File 
names, Selecting a file, Opening Files, Renaming Folders and Files, Creating Folders and files 
Delete a file, Restore a file, Copy a file, Move a file, Removable Storage, Understanding 
extensions, Changing File Associations, Show and Hide extensions 
 

Using the Windows Explorer  + . 
 

The Windows Explorer allows us to explore and manipulate files and folders.  You can 
open the Windows Explorer by right clicking on the Start button and then selecting 
Explore from the options list, or by using the keyboard shortcut  + .   

 
The menu and toolbar options for the folder viewer window have changed drastically 
from Windows XP to Windows 7.  We are going to be using the parts that work similar.  
Screen shots will be on the next page. 
 
If you click on the My Computer or Computer icon in the folder options that will show 
the real physical devices and physical locations.  These physical locations will be the path 
to the document.  File names will be discussed later. 
 
The user document storage has changed on each of the operating systems we have in this 
classroom.    In XP the area will be called My Documents in Window 7 or the 
Libraries/Documents and in Windows Vista the area will be Username/Documents. 
 
These document storage locations are pseudo locations.  The actual path for these areas 
will change for each user account.  For example, the actual path to My Documents in XP  
will be C:\Documents and Settings\username where the user name will change for each 
user account .  Libraries are much more complicated.  They default to location is 
C:\Users\username but more locations can be added.  
 
An excellent video on Libraries can be found here 
http://www.top-windows-tutorials.com/windows-7-tutorial7.html 
 
On any operating system, the My Computer folder will bring up the real  physical 
devices and physical locations.  These physical locations will be the path to the 
document.  File names will be discussed later. 
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Windows Explorer on Windows 7 

 

 
Windows Explorer on Windows XP
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Understanding file names 
 

 
Every file on your computer has a unique filename, that describes exactly where it is.  
The file name has a physical drive letter, and a folder structure on that physical drive, that 
shows the location on that physical storage unit.   
 
Windows offers special locations for data files, such as My Documents or Libraries, that 
persuade users to store their documents in a location segregated from system files and 
program files.  These locations are pseudo locations that represent a more complicated 
physical location.   
 
Windows usually limits file names to 260 characters. But the file name must actually be 
shorter than that, since the complete path (such as C:\Program Files\filename.txt) is 
included in this character count. This is why you might occasionally encounter an error 
when copying a file with a very long file name to a location that has a longer path than its 
current location. 
 
You can't use any of the following characters in a file or folder name: \ / ? : * " > < | 
because they have a special meaning to the operating system 
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 Changing the file View 
 
You can configure how Windows displays the file in the folder by changing the file view.  
This enables you to see icons or the details of each file.  
In Windows Vista or Window 7 
1. Open the folder containing the files you want to view. 
2. Click the View ▼ to open the Views list  
3. Click on the view you want. 

 
In Windows XP 
1. Open the folder containing the files you want to view. 
2. Click on the View 
3. Click on the view you want.  (Thumbnails, Tiles, Icons, List or Details.) 

 
Selecting a File 

Whether you want to rename a file, move several files to a new location, or delete some 
files, you first need to select the files that you want to work with. 
Although this exercise is specifically about selecting files, the technique for selecting 
folders is exactly the same. 
 
SELECT A SINGLE FILE 
1. Open a folder containing the file 
2. Click on the icon  
 
SELECT MULTIPLE FILES 
1. Open the folder containing the file 
2. Click on the icon of the first file you want to select. 
3.  Hold down the CTRL and click each of the other files you want to select.  
 
SELECTING A GROUP OF FILES 
1. Open the folder containing the files. 
2. Position the mouse pointer slightly above and to the left of the first file in the group. 
3. Click and drag the mouse pointer down and to the right until all the  files in the group 

are  selected. 
 
SELECT ALL THE FILES 
In Windows Vista or Windows 7 
1. Open the folder containing all the files 
2. Click on Organize  
3. Click Select ALL 
 
In Windows XP 
1. Open the folder containing the files 
2. Click Edit 
3. Click Select all 
 
Note: A quick way to select al the files in a folder is to press CTRL+ A 
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To Open a file  
 

1.  Double click on the Icon (the picture associated with the file) 
 
To Rename a file 

1.  Double click on the file name of the file 
2.  A text box appears around the file name. 
3.  Type the new name you want to use for the file 
4.  Press Enter 

 
Create a new Folder 

You can create new files and folders directly within the file folder.  The types of files 
and folders you can create will depend on the programs installed on a computer.   
1. Right click on an empty area of the folder.  
2. Select New from the list of options 
3. Select Folder from the list of options 
4. Type in the folder name 
5. Press Enter 
  

UNDO 
There is an undo option on the menu that will undo the most recent change.  The undo 
command can undo a rename, a move, a copy, a change as long as the explorer window is 
open. 
 
1.  Right Click on the white space (empty area) of the file. 
2.  Select Undo  from the menu.  The Undo option will show what the undo will undo. 
 
Note: Pressing Ctrl+Z will undo the last step. 
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Deleting a file 
 
When you have a file that you no longer need, rather than leaving the file to clutter your 
hard drive, you can delete it.   
 
Make sure that you only delete those documents that you created yourself, or that have 
been given to you by someone else.  Do not delete any of the system files or any files 
associated with your programs, or your computer may behave erratically or crash. 
 
1. Open the folder that contains the file you want to delete. 
2. Select the files that you want to delete. 
3. Right click on the file, and then click on Delete from the menu that appears. 
Note: Pressing the Delete key on the keyboard would also delete the selected file. 

 
Restoring a file from the Recycle Bin   

If you immediately realized you deleted a file in error, you can use the undo command 
from the menu to fix the situation.  However if you’ve already closed the explorer 
session, there is still a chance of recovering a file or folder from the recycle bin days or 
even weeks later. 
 
If you delete a file from the hard drive, Window stores the deleted file in a special folder 
called the Recycle Bin.  The deleted files remain in the Recycle Bin, until the Recycle Bin 
is emptied.   
 
Note: Files that are deleted from removable storage do not go to the Recycle Bin. 
 

  
1. Double-click on the Recycle Bin icon. 
2. Click on the file you want to restore 
3. Click Restore this item. 
The file disappears from the Recycle Bin and reappears in its original folder. 
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Copying a file 
You can make an exact copy of a file, which is useful if you want to make a backup of an 
important file on a removable file such as a diskette, USB drive, CD,  DVDs, or SD 
cards..   
The operations here can be performed on a single file, or a group of files or folders. 

 
1. Open the folder containing the file you want to copy 
2. Select the files to be copied 
3. Right click on one of the selected files 
4. Select Copy from the menu 
5. Open the folder where you want to place the copy. 
6. Right click on the white space in the destination folder 
7. Select Paste from the menu 
 
Note: you can use the keyboard shortcuts  Ctrl+C for copy and  Ctrl+V for paste.  
 

Moving a file 
You can move a file to a new location.   
This operations here can be performed on a single file, or a group of files or folders. 

              
1. Open the folder containing the file you want to copy 
2. Select the files to be moved 
3. Right click on one of the selected files 
4. Select Cut from the menu 
5. Open the folder where you want to move the file to. 
6. Right click on the white space in the destination folder 
7. Select Paste from the menu. 
 
Note: you can use the keyboard shortcuts Ctrl+X for cut and  Ctrl+V for paste.  
 

Tip.  Having two explorers windows open can help those of us who are easily distracted. 
 
 
Note: Files can be managed by dragging too.  If you drag a file from one physical device to 
another, it is treated as a copy.  If you drag files from one folder to another on the same physical 
device, it is treated as a move, and the files disappear from the original directory.    
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Removable Storage Devices 
There are lots of kinds of removable storage devices such as diskettes, SD Cards, CDs, 
DVDs, USB drives .  The number one rule when using these types of devices is that 
all programs using these files MUST be closed before the media is removed.  With a 
USB device, there will be a little eject icon in the notification area.  Use the ejection 
button to make sure that all files on this device are closed. 
 
USB Drives. 
A USB drive is a very convenient way to store data.  Its very easy to use and compatible 
with all current Windows computers.  Any application can open, read and write files on 
the drive.   
 1. Plug the drive into a usb slot and wait for Windows to detect the new hardware  
 2. Close any Windows that open up. 
 3. You can now do any kind of file operations you want. 
 4. Close any application that are using files you have stored on the USB drive. 
 5. Close any windows that are viewing the contents of the USB Drive 
 6. Click on the EJECT icon in the notification area of the task bar 
 7. Select the USB Drive 
 8. Wait for a message that says it is now safe to remove the drive 
 9. Unplug the USB Drive 
 
SD Cards 
An SD Card is the type of memory card in your digital camera.  A few of our computers 
have SD Slots that make it very easy to see your pictures on the big screen and mail 
them.  We also have an SD to USB adapter in the file cabinet if those computers are in 
use. 
 
CD’s and DVD’s 
Computers these days usually come with a CD or DVD writer.  CD’s and DVD’s are 
inexpensive and can store a lot of data.  A CD can store 650MB worth of data and a DVD 
has a 4.7GB.  A DVD writer can write both CD’s and DVDs.  A CD writer can only write 
CDs. There are two types CD-R and CD-RW.  The -RW stands for rewritable, the -R 
write once.  DVD media hasn’t been standardized so there are “minus” – and “plus”” 
compatibility issues.  Make sure you know what kind of media can be written on with 
your DVD writer.   
 
The methods for writing musical CD’s and video DVD’s are different than the methods 
for creating data DVDs.  When working with data  CDs or DVDs there are two types of 
formatting Live and Mastered.  There are many software applications to write to CD’s 
and DVD’s that make the process pretty easy but Windows XP, Vista and 7 offer native 
mastering, and Windows Vista and Windows 7 offer native Live File Systems too.  When 
you use the Mastered format, files are stored in a "staging area" until you decide to burn 
the disc.  Discs formatted with the Live File System option work like a USB flash drive 
or floppy disk, meaning you can copy files to disc immediately without having to burn 
them.  When you use the Live File System format with rewriteable discs such as CD-RW 
and DVD-RW, you can also erase unwanted files from a disc to recover space, which is 
not possible with Mastered discs. On the other hand, Mastered discs are more compatible 
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with older computers, previous versions of Windows, and other devices such as CD and 
DVD players. 
 
This is the Mastered method of writing a data CD  
1. Place new CD in CD burner (CD drive) 
2.  Close any windows that might open 
3.  Organize or locate file/folders to be burned to CD 
4.  Select files/folders to be burned to CD 
5.  Right click on selected item(s) 
6.  On menu: point to “send to” 
7.  On sub menu that appears choose: CD drive 
8.  Left click message that appears in lower right of screen that says: 
     “You have files waiting to be written to the CD” 
9.   In window that opens click on “Write these files to CD” 
10. You should seen icons with a down pointing arrow on them. These waiting to be 

written (burned) to CD 
11. Follow the instructions in the windows wizard that appears and your information will 

be copied to the CD  
12. Label the CD appropriately so that you will know what information is now on it 

*** Note the method for writing AUDIO CDs is different. 
 

 
Understanding Extensions 
 

A file name extension is a set of characters that helps Windows understand what kind of 
information is in a file and what program should open it. It is called an extension because 
it appears at the end of the file name, following a period. In the file name test.txt, the 
extension is txt.  It tells Windows that this is a text file that can be opened by programs 
associated with that extension. 

Changing the file association  
Fixing or changing a file association is very simple. For example, if you accidentally 
associated .pdf files with a program that cannot open them, you can change the 
association back to Adobe Reader (or another PDF reader that can open them). Simply 
follow this procedure: 

If you're using Windows 2000, or Windows XP 
Right-click the respective file, for example a PDF file. 
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Select > Open With from the right-click options. 

 

 

   If you're using Windows Vista, or Windows 7 

Right-click the respective file, for example a PDF file. 
Select > Open With from the right-click menu. 
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The > Open with window will open and now you can either pick a program from the list 
of > Other Programs or click the > Browse… button and find the application you want to 
open this file type with. 

 

• If you want to make the change permanent, check the box next to > Always use the 
selected program to open this kind of file. 

• Finally, click > OK and, given you checked the respective box, all your PDF files should 
now open with the program of your choice. 



Working with Files and Folders  page 12 of 16 

2/2/2012 Vicky Getz www.getzweb.net/vistamenu.html 

Getting an Over view of all the extensions on your computer. 
 

If you're using Windows 2000, or Windows XP 

If you want to get an overview of all file associations on your computer or change several 
at once, you can go to > Start > Control Panel >  Folder Options 

Then select File Types  tab and then scroll down the list of Registered file types. 

 Here you can browse all file types. Click on > Change… to pick a new tool to open the 
respective file type. 

  

Every program that's installed on your computer is designed to open one or more 
particular file types, each of which is identified by a file name extension.  If you have 
more than one program on your computer capable of opening a file type, then one 
program is set as the default. The Change  button can change the program that 
automatically opens a type of file. 
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If you're using Windows Vista, or Windows 7 

If you want to get an overview of all file associations on your computer or change several 
at once, you can go to > Start > Control Panel > Programs > Default Programs > 
Associate a file type or protocol with a specific program. Here you can browse all file 
types. Click on > Change program… to pick a new tool to open the respective file type. 

 

Note that .lnk files should not be associated with a specific program (unknown 
application) and hence you cannot fix a broken .lnk file association this way! 

 
Every program that's installed on your computer is designed to open one or more 
particular file types, each of which is identified by a file name extension.  If you have 
more than one program on your computer capable of opening a file type, then one 
program is set as the default. The Change Program button can change the program that 
automatically opens a type of file. 

. 
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Showing and hiding Extensions 
 

Microsoft defaults to extensions not being visible.  There is a huge difference of opinion 
among users as to whether they should be visible or not.  Usually, file name extensions 
should not be changed because you might not be able to open or edit the file after doing 
so.  If  the file name extensions are visible, and you go to  rename a file, there is a danger 
of  accidentally changing the file extension. Windows will warn you that changing the 
file name extension might cause the file to stop working properly.   
 

If you're using Windows XP 

1. On your desktop, open My Computer. If you don't see My Computer, then open any 
folder. 

2. Select the Tools menu, & then select Folder Options ….  

 

3. In the Folder Options windows, click on the View tab. 
4. Uncheck the box next to Hide file extensions for known file types (Note that I have 

checked and unchecked other boxes that may not apply to you. If you would like to make 
your View tab resemble mine below, go right ahead; however, it is not necessary if all 
that you wish to do is reveal the "dot 3" file extension.).  
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5. Click OK to close the Folder Options window. 
6. Close the My Computer window. 

If you're using Windows Vista or 7 

1. Click on the Start button > Control Panel > Appearance and Personalization > Folder 
Options (Two thoughts: [1] Boy, Vista is a lot more complicated than earlier versions of 
Windows! [2] You can always use the Search box on the Start menu & just search for 
"Folder Options" there, which may be the easiest option.) 

2. In the Folder Options windows, click on the View tab. 
3. Uncheck the box next to Hide file extensions for known file types. 

 

4. Click OK to close the Folder Options window. 

 
Related Videos 
 
Windows XP Windows Tutorials 
http://www.top-windows-tutorials.com/free-windows-xp-tutorials.html 
 
Windows 7 Windows Explorer Tutorial 
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http://www.top-windows-tutorials.com/windows-7.html 
 
Working with Files 
http://www.top-windows-tutorials.com/free-windows-tutorials.html 
 
 
 
 


